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BAB IV 

PEMBUATAN ALAT 

 

4.1. Pembuatan Hardware 

Pada tahapan pembuatan hardware dibagi menjadi dua, yaitu pembuatan 

rangkaian mekanik dan pembuatan rangkaian elektrik. 

4.1.1. Rancangan Mekanik 

Pada rancangan mekanik, dilakukan proses pembuatan perangkat mekanik / 

rangka mesin CNC yang telah dirancang sebelumnya berdasarkan desain yang 

ditunjukkan pada Gambar 3.4 Desain 3D Mesin CNC. Pembuatan ini bertujuan untuk 

mendukung kinerja alat dan merealisasikan desain sesuai dengan kondisi fisik 

sebenarnya. 

Alat dan bahan yang digunakan dalam proses pembuatan alat perangkat 

Mekanik / rangka mesin CNC dapat dilihat pada tabel berikut: 

Tabel 4-1 Alat dan Bahan Pembuatan Hardware Mekanik 

NO ALAT JUMLAH NO BAHAN JUMLAH 

1.  Obeng 1 Buah 1.  Motor Stepper Nema 17 3 Buah 

2.  Gergaji 1 Buah 2.  Motor DC 775 1 Buah 

3.  Meteran 1 Buah 3.  Limit Switch 3 Buah 

4.  Spidol 1 Buah 4.  Pulley 2GT 20T 3 Buah 

5.  Bor & 

Mata Bor 

4mm 

1 Buah 5.  Belt GT2 6mm 1,5 Meter 

6.  Kunci L 1 Buah 6.  Lead Screw T8 Lead 8 

Pitch 2mm 4Start 100mm 

1 Buah 

7.  Tang 

Potong 

1 Buah 7.  T Nut T8 Lead 8 Pitch 

2mm 4Start 

2 Buah 

8.  Tang 

Lancip 

1 Buah 8.  Aluminium Profil 2020 1,5 meter 
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Pembuatan hardware mekanik sesuai rancangan Gambar 3.4 Desain 3D Mesin CNC 

dilakukan sebagai berikut : 

1. Pemotongan profil aluminium 2020 menggunakan gergaji sesuai dengan 

kebutuhan rangka mesin CNC, dengan rincian ukuran: 1 × 310,9 mm, 2 × 

300 mm, dan 2 × 270 mm. 

NO ALAT JUMLAH NO BAHAN JUMLAH 

9.  Hand Tap 

5mm 

1 Buah 9.  Coupling 2 Buah 

10.  Ragum 1 Buah 10.  Besi As Shaft 5mm 1 Meter 

11.  Waterpas

s 

Indicator 

1 Buah 11.  Roda V Wheel 625ZZ 12 Buah 

12.  Amplas Secukupnya 12.  Rangka Kaki (3D 

Filamen) 

4 Buah 

   13.  Rangka Tiang Samping 

Kanan & Kiri (3D 

Filamen) 

1 Buah 

   14.  Rangka Atas (3D 

Filamen) 

1 Buah 

   15.  Rangka Spindel (3D 

Filamen) 

1 Buah 

   16.  Rangka Timing Belt (3D 

Filamen) 

4 Buah 

   17.  Rangka Latar (3D 

Filamen) 

1 Buah 

   18.  Bearing 608ZZ 1 Buah 

   19.  Bearing 625ZZ 1 Buah 

   20.  Mur, Ring dan Baut Secukupn

ya 
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Gambar 4.1 Pemotongan Aluminium Profil 2020 

(Sumber : Dokumen Pribadi, 2025) 

2. Kemudian pemotongan besi assental berdiameter 5 mm yang berfungsi 

sebagai transmisi daya putar motor stepper sekaligus penopang rangka 

sumbu Y dan Z, dengan rincian ukuran: 1 × 302 mm, 2 × 322,9 mm, dan 2 

× 127,5 mm. 

 

Gambar 4. 2 Pemotongan Besi Assental 5mm 

(Sumber : Dokumen Pribadi, 2025) 

3. Pelubangan dan pembuatan ulir pada potongan aluminium profil 2020 

dilakukan menggunakan hand tap untuk menyiapkan tempat perekat baut. 

 

Gambar 4. 3 Pembuatan ulir pada profil aluminium 2020 

(Sumber : Dokumen Pribadi, 2025) 

4. Amplas potongan besi assental dan aluminium profil 2020 untuk 

menghilangkan kotoran serta sisa-sisa serpihan yang menempel di 

permukaannya. 
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Gambar 4. 4 Pengamplasan Besi Assental 5mm 

(Sumber : Dokumen Pribadi, 2025) 

5. Potongan aluminium profil 2020 dengan ukuran 2 × 300 mm, dan 2 × 270 

mm dipasangkan dengan rangka kaki (hasil cetak 3D/filamen) 

menggunakan baut sebagai pengikatnya. 

 

Gambar 4. 5 Pemasangan Rangka Kaki Mesin CNC 

(Sumber : Dokumen Pribadi, 2025) 

6. Rangka tiang samping kanan dan kiri (hasil cetak 3D/filamen) serta roda V-

wheel dipasang pada aluminium profil berukuran 300 mm. 

 

Gambar 4. 6 Pemasangan Rangka Tiang Samping Kanan dan Kiri serta Roda V-

Wheel 

(Sumber : Dokumen Pribadi, 2025) 

7. Aluminium profil 2020 berukuran 302 mm dan Timing Belt GT2 lebar 6mm 

untuk sumbu X dipasangkan pada salah satu rangka tiang samping (kanan 

atau kiri) hasil cetak 3D/filamen sebagai penyangga rangka atas. 
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Gambar 4. 7 Pemasangan Aluminium Profil 2020 dan Timing Belt GT2 Lebar 

6mm untuk Rangka Atas 

(Sumber : Dokumen Pribadi, 2025) 

8. Roda V-wheel dipasangkan pada rangka atas (hasil cetak 3D/filamen) 

menggunakan baut dan mur sebagai pengikat. 

 

Gambar 4. 8 Pemasangan Roda V-Wheel pada Rangka Atas 

(Sumber : Dokumen Pribadi, 2025) 

9. Motor stepper NEMA 17 untuk sumbu X dipasangkan pada pulley 2GT 20T. 

 

Gambar 4. 9 Pemasangan Pulley 2GT 20T pada Motor Stepper Nema 17 sumbu 

X 

(Sumber : Dokumen Pribadi, 2025) 

10. Limit switch sumbu Z dan motor stepper NEMA 17 sumbu X yang telah 

dipasangi pulley 2GT 20T dipasangkan pada rangka atas (hasil cetak 

3D/filamen). 
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Gambar 4. 10 Pemasangan Limit Switch sumbu Z dan Motor Stepper Nema 17 

sumbu X pada Rangka Atas 

(Sumber : Dokumen Pribadi, 2025) 

11. Bearing 608ZZ dengan diameter dalam 8 mm dipasangkan pada rangka atas 

(hasil cetak 3D/filamen) sebagai penyangga idler pulley sumbu Z. 

 

Gambar 4. 11 Pemasangan Bearing 608ZZ pada Rangka Atas 

(Sumber : Dokumen Pribadi, 2025) 

12. T-nut T8 lead 8 pitch 2 mm 4 start dipasangkan pada lubang rangka spindle 

(hasil cetak 3D/filamen) dengan diameter ±9,7 mm. 

 

Gambar 4. 12 Pemasangan T-nut T8 lead 8 pitch 2 mm 4 start pada Rangka 

Spindle 

(Sumber : Dokumen Pribadi, 2025) 

13. Rangka spindle (hasil cetak 3D/filamen) yang telah dipasangi T-nut T8 lead 

8 pitch 2 mm 4 start serta besi assental berukuran 2 × 127,5 mm dengan 

diameter 5 mm dipasangkan pada rangka atas (hasil cetak 3D/filamen). 
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Gambar 4. 13 Pemasangan Rangka Spindle dan Besi Assental pada Rangka Atas 

(Sumber : Dokumen Pribadi, 2025) 

14. Motor stepper NEMA 17 untuk sumbu Z dipasangkan pada rangka atas 

(hasil cetak 3D/filamen), kemudian dihubungkan ke lead screw T8 lead 8 

pitch 2 mm 4 start sepanjang 100 mm melalui coupling. Lead screw tersebut 

juga terhubung ke rangka spindle (hasil cetak 3D/filamen). 

 

Gambar 4. 14 Pemasangan Motor Stepper NEMA 17 sumbu Z, Coupling, dan 

Lead Screw T8 pada Rangka Spindle dan Rangka Atas 

(Sumber : Dokumen Pribadi, 2025) 

15. Rangka atas (hasil cetak 3D/filamen) yang telah dipasangi komponen 

sumbu X dan Z dipasangkan pada aluminium profil 2020 berukuran 302 

mm. Timing belt GT2 lebar 6 mm untuk sumbu X dikencangkan, setelah 

sebelumnya terpasang pada salah satu sisi. Selanjutnya, dua batang besi 

assental berdiameter 5 mm dengan panjang masing-masing 322,9 mm 

dipasangkan melintang di antara rangka tiang samping kanan dan kiri (hasil 

cetak 3D/filamen). Motor stepper NEMA 17 untuk sumbu Y juga 

dipasangkan pada rangka, disertai pulley 2GT 20T yang terhubung ke 

batang assental 5 mm berukuran 302 mm melalui coupling. Pada sisi 

seberangnya, dipasangkan pulley 2GT 20T tambahan yang berfungsi 

sebagai penyeimbang pergerakan poros sumbu Y. 
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Gambar 4. 15 Pemasangan dan Perakitan Seluruh Komponen Sumbu X, Y, dan Z 

(Sumber : Dokumen Pribadi, 2025) 

16. Pasang dan kencangkan dua timing belt GT2 pada sumbu Y, masing-masing 

pada sisi motor dan sisi seberangnya. Belt dipasangkan pada rangka penahan 

timing belt (hasil cetak 3D/filamen) yang terpasang pada aluminium profil 

2020. 

 

Gambar 4. 16 Pemasangan Timing Belt GT 2 pada sumbu Y 

(Sumber : Dokumen Pribadi, 2025) 

17. Pasang komponen limit switch pada masing-masing sumbu X, Y, dan Z. 

 

Gambar 4. 17 Pemasangan Limit Switch 

(Sumber : Dokumen Pribadi, 2025) 

18. Pasang motor DC 775 pada rangka spindle (hasil cetak 3D/filamen) sebagai 

motor pemutar spindle. 
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Gambar 4. 18 Pemasangan Motor Spindle 

(Sumber : Dokumen Pribadi, 2025) 

19. Pasang rangka latar (hasil cetak 3D/filamen) pada rangka aluminium profil 

mesin CNC. 

 

Gambar 4. 19 Pemasangan Latar / Bed (Meja Kerja) 

(Sumber : Dokumen Pribadi, 2025) 

20. Perakitan rangka atau hardware mekanik mesin CNC telah selesai 

dilakukan. 

 

Gambar 4. 20 Hasil Perakitan Hardware Mekanik 

(Sumber : Dokumen Pribadi, 2025) 

4.1.2. Rancangan Elektrik 

Pada rancangan mekanik, dilakukan proses pembuatan perangkat elektrik 

mesin CNC yang telah dirancang sebelumnya berdasarkan desain yang ditunjukkan 

pada Gambar 3.2 Illustrative Wiring Diagram dan Gambar 3.3 Ilustrasi 

Pemasangan Komponen pada Panel (Wiring Diagram). Pembuatan ini bertujuan 
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untuk mendukung kinerja alat dan merealisasikan desain sesuai dengan kondisi 

fisik sebenarnya. 

Alat dan bahan yang digunakan dalam proses pembuatan alat perangkat 

elektrik mesin CNC dapat dilihat pada tabel berikut : 

Tabel 4- 2 Alat dan Bahan Pembuatan Hardware Elektrik 

NO ALAT JUMLAH NO BAHAN JUMLAH 

1.  Obeng 1 Buah 1.  Box Panel 30 cm × 40 

cm × 18 cm 

1 Buah 

2.  Penggaris 1 Buah 2.  Arduino Uno & Kabel 

USB 

1 Buah 

3.  Spidol 1 Buah 3.  CNC Shield 1 Buah 

4.  Mesin Bor Set 1 Buah 4.  Driver TMC2209 3 Buah 

5.  Gerinda 1 Buah 5.  Arduino Nano 1 Buah 

6.  Kikir 1 Buah 6.  LCD 16 × 2 & I2C 1 Buah 

7.  Tang Potong 1 Buah 7.  Steker 1 Buah 

8.  Tang Lancip 1 Buah 8.  Power Supply 12V 1 Buah 

9.  Tang Press 

Skun 

1 Buah 9.  Modul LM2596 

Stepdown 

1 Buah 

10.  Cutter 1 Buah 10.  MCB 4A 1 Buah 

11.  Solder 1 Buah 11.  Relay Optocoupler 5V 

1 Channel  

1 Buah 

12.  Multimeter 1 Buah 12.  Lampu Panel  2 Buah 

13.  Double Tape 

Foam 

Secukupnya 13.  Mini Voltmeter DC 1 Buah 

14.  Timah Solder Secukupnya 14.  Resistor 4,7K Ω 8 Buah 

   15.  Dioda 1N5408 1 Buah 

   16.  Pilot Lamp 2 Buah 

   17.  Watt Meter DC 1 Buah 

   18.  Push Button NO 2 Buah 
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NO ALAT JUMLAH NO BAHAN JUMLAH 

   19.  Emergency Push 

Button 

1 Buah 

   20.  Cooling Fan 12VDC 1 Buah 

   21.  Terminal Konektor 1 Buah 

   22.  Capit Buaya 2 Buah 

   23.  LED 5mm & Resistor 

220 Ω 

1 Buah 

   24.  Kabel Duct 25 × 25 

mm 

23 Cm 

   25.  Konektor JST Secukupnya 

   26.  Kabel Jumper Secukupnya 

   27.  Kabel NYAF Secukupnya 

   28.  Kabel NYAM Secukupnya 

   29.  Kabel Ties & 

Konektor Skun Kabel 

Secukupnya 

   30.  Isolasi Bakar Kabel Secukupnya 

   31.  Mur, Ring dan Baut Secukupnya 

 

Pembuatan hardware elektrik sesuai rancangan Gambar 3.2 Illustrative 

Wiring Diagram dan Gambar 3.3 Ilustrasi Pemasangan Komponen pada Panel 

(Wiring Diagram) dilakukan sebagai berikut : 

1. Buat layout dan lakukan pengukuran posisi lubang pada panel yang akan 

dibor. 

 

Gambar 4. 21 Layout dan pengukuran posisi lubang pada panel 

(Sumber : Dokumen Pribadi, 2025) 
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2. Lakukan pengeboran pada box panel sesuai dengan hasil pengukuran dan 

desain yang telah dibuat. 

 

Gambar 4. 22 Pengeboran pada box panel 

(Sumber : Dokumen Pribadi, 2025) 

3. Pasang komponen-komponen pada box panel sesuai dengan layout yang 

telah ditentukan. 

 

Gambar 4. 23 Pemasangan Komponen pada Box Panel 

(Sumber : Dokumen Pribadi, 2025) 

4. Pasang seluruh kabel pada masing-masing komponen sesuai dengan gambar 

ilustratif wiring diagram. 

 

Gambar 4. 24 Pemasangan Kabel pada Setiap Komponen 

(Sumber : Dokumen Pribadi, 2025) 

5. Atur Tegangan Referensi (Vref) Driver Motor Stepper 

Pengukuran tegangan referensi (Vref) pada driver motor stepper TMC2209 

dilakukan menggunakan multimeter digital. Langkah-langkah pengukuran 
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mengacu pada penjelasan di Subbab 2.2.4 CNC Shield Arduino Uno & 

Driver TMC2209 pada bagian Perhitungan Tegangan Referensi (Vref) : 

• Hubungkan driver ke catu daya (power supply) 12V DC dan pastikan 

sistem dalam keadaan hidup (powered ON). 

• Atur multimeter ke mode voltmeter DC (VDC). 

• Sambungkan probe hitam (negatif) multimeter ke ground (GND) dari 

sistem (misalnya pin GND Arduino atau power supply). 

• Sambungkan probe merah (positif) ke pin pengukuran Vref pada modul 

driver TMC2209 (Trimpot Driver). 

• Baca hasil pengukuran pada layar multimeter 

 

Gambar 4. 25 Pengukuran Tegangan Referensi (VRef) Driver TMC2209 

(Sumber : Dokumen Pribadi, 2025) 

Jika nilai Vref sudah diketahui, maka arus RMS per fasa yang dialirkan ke 

motor stepper dapat dihitung dengan rumus : 

𝐼 𝑅𝑀𝑆 =
𝑉𝑟𝑒𝑓

0,71 × 2
=  

1,19 𝑉𝐷𝐶

1,42
= 0,83𝐴 𝑝𝑒𝑟 𝑓𝑎𝑠𝑎 

Dengan arus 0,83 A per fasa, driver bekerja dalam batas aman untuk motor 

NEMA 17 17HS8401 yang memiliki spesifikasi arus max sekitar 1,7 A. 

6. Rapikan kabel-kabel komponen 

 

Gambar 4. 26 Perapian Kabel-Kabel komponen 

(Sumber : Dokumen Pribadi, 2025) 
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7. Perakitan rangka atau hardware elektrik mesin CNC telah selesai dilakukan. 

 

Gambar 4. 27 Hasil Perakitan Hardware Elektrik 

(Sumber : Dokumen Pribadi, 2025) 

 

4.2. Pembuatan Software 

Pembuatan perangkat lunak pada proyek mesin CNC ini bertujuan untuk 

mengatur alur kerja mesin mulai dari proses penerjemahan desain PCB hingga 

eksekusi gerakan motor oleh Arduino Uno. Penggunaan firmware GRBL pada 

mikrokontroler Arduino Uno menjadi inti sistem kontrol gerakan mesin, yang 

diunggah melalui Arduino IDE. Untuk merancang jalur dan layout PCB, digunakan 

perangkat lunak Eagle sebagai alat desain skematik dan board. File hasil desain 

tersebut kemudian diproses dengan FlatCAM untuk menghasilkan G-code sesuai 

kebutuhan mesin CNC. Selanjutnya, G-code dijalankan menggunakan Universal 

G-code Sender (UGS) sebagai antarmuka pengirim perintah ke mesin CNC.  

Tanpa peran sistem perangkat lunak ini, keseluruhan komponen hanya akan 

terhubung secara fisik tanpa mampu menjalankan fungsi kerja yang terprogram. 

Oleh karena itu, keakuratan dan keberhasilan dalam proses pembuatan perangkat 

lunak akan sangat menentukan performa dan keandalan sistem mesin CNC secara 

keseluruhan 

4.2.1. Proses GRBL Firmware 

GRBL merupakan firmware open-source berbasis bahasa C yang dirancang 

khusus untuk mengontrol mesin CNC melalui mikrokontroler Arduino. Firmware 

ini bersifat gratis dan dapat diunduh kapan pun melalui repositori resminya, serta 

mendukung interpretasi perintah G-code secara langsung untuk menggerakkan 

motor stepper. Pada proyek ini, GRBL diunggah ke Arduino Uno sebagai otak 
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pengendali gerakan sumbu mesin CNC. Berikut Langkah-langkah penginstalan 

GRBL : 

1. Buka Arduino IDE 

Untuk menginstal atau mengunggah firmware GRBL ke Arduino Uno, 

diperlukan aplikasi Arduino IDE sebagai alat pemrograman utama. 

 

Gambar 4. 28 Proses Membuka Aplikasi Arduino IDE 

(Sumber : Dokumen Pribadi, 2025) 

 

2. Unduh GRBL 

Unduh firmware GRBL dari situs resmi https://github.com/gnea/grbl dalam 

format file .zip. 

 

Gambar 4. 29 Proses Unduh Firmware GRBL 

(Sumber : Dokumen Pribadi, 2025) 

https://github.com/gnea/grbl
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3. Ekstrak GRBL 

Ekstrak file grbl-master.zip yang telah diunduh. 

 

Gambar 4. 30 Proses Ekstrak File GRBL 

(Sumber : Dokumen Pribadi, 2025) 

 

4. Buka File grblUpload.ino 

Setelah mengekstrak file grbl-master.zip, buka folder grbl, kemudian masuk 

ke direktori examples > grblUpload, lalu pilih dan buka file grblUpload.ino 

melalui Arduino IDE. 

 

Gambar 4. 31 Pemilihan File grblUpload.ino 

(Sumber : Dokumen Pribadi, 2025) 
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5. Upload Library GRBL 

Setelah file grblUpload.ino dibuka, unggah firmware GRBL ke Arduino 

Uno melalui kabel USB. Pastikan terlebih dahulu memilih jenis board 

"Arduino Uno" dan port komunikasi yang sesuai melalui menu Tools > 

Board dan Tools > Port pada Arduino IDE. 

 

Gambar 4. 32 Proses Unggah Library GRBL 

(Sumber : Dokumen Pribadi, 2025) 

 

6. Selesai Upload GRBL 

Proses unggah firmware GRBL ke Arduino Uno telah berhasil. Arduino kini 

siap digunakan sebagai pengendali utama sistem mesin CNC untuk 

menjalankan seluruh rangkaian gerakan berdasarkan perintah G-code. 

4.2.2. Proses Software Eagle 

Proses perancangan awal jalur rangkaian PCB pada proyek mesin CNC ini 

dilakukan menggunakan perangkat lunak Autodesk Eagle. Eagle merupakan 

software desain elektronik berbasis CAD (Computer Aided Design) yang digunakan 

untuk membuat skematik rangkaian serta layout papan PCB secara digital. Berikut 

langkah-langkah pembuatan rangkaian pada Autodesk Eagle : 

 

 

 



113 

 

 

 

1. Buka Autodesk Eagle 

 

Gambar 4. 33 Proses Membuka Aplikasi Autodesk Eagle 

(Sumber : Dokumen Pribadi, 2025) 

 

2. Pilih Menu Projects 

Pada tampilan awal Eagle, pilih menu Projects, lalu masuk ke folder 

Projects. Klik kanan pada area tersebut, kemudian pilih New Project untuk 

membuat proyek baru. 

 

Gambar 4. 34 Pemilihan Menu Projects 

(Sumber : Dokumen Pribadi, 2025) 

 

3. Pilih Menu Schematic 

Setelah membuat proyek baru, beri nama sesuai keinginan. Selanjutnya, klik 

kanan pada nama proyek tersebut, pilih New, lalu pilih Schematic untuk 

mulai membuat diagram skematik rangkaian. 
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Gambar 4. 35 Pemilihan Menu Schematic 

(Sumber : Dokumen Pribadi, 2025) 

 

4. Pemilihan komponen 

Pada lembar kerja Schematic, pilih menu Add Part untuk menambahkan 

komponen-komponen elektronik yang dibutuhkan dalam perancangan 

rangkaian, baik dalam bentuk THT (Through Hole) maupun SMD (Surface 

Mount Device), sesuai kebutuhan layout PCB. 

 

Gambar 4. 36 Pemilihan Menu Add Part 

(Sumber : Dokumen Pribadi, 2025) 
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5. Koneksikan Komponen 

Setelah semua komponen yang dibutuhkan ditambahkan, lakukan 

pengaturan tata letak (layout) skematik dan hubungkan antar komponen 

menggunakan fitur Net. Alternatifnya, dapat menggunakan fitur Label dan 

menghubungkannya berdasarkan penamaan (Name) yang sama untuk 

menyederhanakan jalur koneksi. 

 

Gambar 4. 37 Pengkoneksian Komponen-komponen 

(Sumber : Dokumen Pribadi, 2025) 

 

6. Generate ke Board 

Setelah rangkaian skematik selesai, lakukan proses konversi ke tampilan 

Board Layout dengan memilih menu Generate/Switch to Board pada 

toolbar. 

 

Gambar 4. 38 Proses Konversi ke tampilan Board 

(Sumber : Dokumen Pribadi, 2025) 
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7. Layout Board PCB 

Setelah masuk ke tampilan Board Layout, susun komponen-komponen 

secara rapi di area board agar jalur tidak saling bertabrakan. Ubah satuan 

grid ke milimeter (mm) agar lebih presisi dalam penempatan. 

Selanjutnya, sambungkan garis Airwire menggunakan fitur Route Airwire, 

dan atur ketebalan jalur sesuai kebutuhan melalui parameter Width. Proses 

routing dapat dilakukan pada layer atas (Top) atau layer bawah (Bottom) 

melalui pengaturan Layer Settings. 

Dalam proyek mesin CNC PCB ini, digunakan desain single layer, sehingga 

seluruh jalur dirancang hanya pada satu layer. Jika menggunakan desain 

dual layer, koneksi antar jalur dapat dibuat menggunakan via. 

Untuk menentukan dimensi fisik papan PCB, gunakan tool Line Dimension 

pada tampilan Board Layout. 

 

Gambar 4. 39 Pembuatan Layout Board PCB 

(Sumber : Dokumen Pribadi, 2025) 

 

8. Konversi ke Gerber 

Setelah proses layout papan PCB selesai, lakukan konversi desain menjadi 

file Gerber untuk keperluan proses produksi. Caranya yaitu dengan 

membuka menu CAM Processor, lalu pilih pengaturan yang sesuai dan klik 

tombol Process Job untuk menghasilkan file output Gerber. 
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Gambar 4. 40 Proses Konversi ke File Gerber 

(Sumber : Dokumen Pribadi, 2025) 

 

9. Hasil File Gerber 

Setelah proses konversi melalui fitur CAM Processor, file Gerber dapat 

ditemukan di lokasi penyimpanan proyek Eagle. Biasanya, hasil output 

disimpan dalam folder CAMOutputs atau GerberFiles. 

File-file Gerber yang dihasilkan tersebut selanjutnya siap digunakan untuk 

proses konversi menjadi G-code pada tahap berikutnya menggunakan 

software lain, seperti FlatCAM. 

 

Gambar 4. 41 Tampilan Hasil File Gerber 

(Sumber : Dokumen Pribadi, 2025) 
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4.2.3. Proses Software Flatcam 

FlatCAM merupakan perangkat lunak open-source yang digunakan untuk 

mengubah file Gerber dan Drill hasil dari software desain PCB (seperti 

Eagle) menjadi G-code, yaitu format perintah yang dapat dibaca oleh mesin 

CNC. 

Tanpa konversi melalui FlatCAM, desain jalur dan titik pengeboran pada 

PCB tidak dapat dijalankan oleh sistem kontrol CNC. Oleh karena itu, 

proses ini merupakan tahapan penting sebelum file dapat dieksekusi oleh 

firmware GRBL pada Arduino. Berikut ini adalah langkah-langkah 

penggunaan software FlatCAM untuk mengonversi file Gerber menjadi G-

code : 

1. Buka Flatcam 

Buka Flatcam kemudian pilih menu File > Open > Open Gerber. 

 

Gambar 4. 42 Proses Open File Gerber 

(Sumber : Dokumen Pribadi, 2025) 

 

2. Masukkan File Gerber 

Setelah membuka aplikasi FlatCAM, klik menu "Open Gerber", kemudian 

pilih file Gerber hasil dari proses ekspor di software Eagle. File Gerber 

biasanya berada dalam folder CAMOutputs atau GerberFiles, tergantung 

pada lokasi penyimpanan proyek Eagle. 
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Gambar 4. 43 Proses Input File gerber 

(Sumber : Dokumen Pribadi, 2025) 

 

Pilih file Gerber yang mewakili layer jalur PCB yang telah dibuat 

sebelumnya, seperti copper_bottom untuk layer bawah atau copper_top 

untuk layer atas, sesuai dengan jenis desain PCB yang digunakan. 

3. Masukkan File Excellon 

Setelah file Gerber dimasukkan untuk memuat jalur layout PCB, langkah 

selanjutnya adalah membuka file Excellon dengan memilih menu "Open 

Excellon". File ini berfungsi untuk memuat data lubang (drill) pada papan 

PCB seperti lubang kaki komponen. 

 

Gambar 4. 44 Proses Open File Excellon 

(Sumber : Dokumen Pribadi, 2025) 
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Setelah membuka menu Open Excellon, pilih file drill (biasanya berekstensi 

.drl) yang terdapat di dalam folder CAMOutputs atau DrillFiles hasil ekspor 

dari Eagle. 

 

Gambar 4. 45 Proses Input File drill 

(Sumber : Dokumen Pribadi, 2025) 

 

4. Rapikan Layout File 

Setelah file Gerber dan Excellon berhasil dimuat, pastikan posisi keduanya 

berada dekat dengan titik koordinat (X0, Y0). Jika posisi belum rapi atau 

terlalu jauh dari origin, geserlah objek ke dekat koordinat awal (origin) agar 

proses pemrosesan toolpath dan pemotongan CNC berjalan lebih presisi dan 

efisien. 

 

Gambar 4. 46 Penempatan File Gerber dan Excellon di Dekat Titik Koordinat X0 

Y0 

(Sumber : Dokumen Pribadi, 2025) 
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5. Pengaturan File Gerber 

Klik dua kali pada file Gerber yang telah dimasukkan, misalnya 

copper_top.gbr, untuk membuka pengaturan detail file tersebut. 

Selanjutnya, pilih menu Isolation Routing guna memulai proses pembuatan 

jalur isolasi pada layout PCB. 

 

Gambar 4. 47 Pemilihan Menu Isolation Routing GRBL Object 

(Sumber : Dokumen Pribadi, 2025) 

 

Setelah memilih file Gerber seperti copper_top.gbr, menu Isolation Tool 

akan muncul untuk menentukan parameter pembuatan jalur isolasi 

(isolation routing). Berikut penjelasan tiap bagian : 

 

Gambar 4. 48 Menu Isolation Routing 

(Sumber : Dokumen Pribadi, 2025) 
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a. Tools Table 

• Diameter : Diisi dengan ukuran alat milling atau V-bit yang 

digunakan.  

Contoh : 0.7 mm menunjukkan diameter alat potong 

• TT (Tool Type) : Biasanya bisa diberi label atau jenis alat, misal C1 

sebagai identifikasi. 

Tabel 4- 3 Jenis-jenis Tool Type di Flatcam 

Kode Makna Umum Penjelasan 

C1 Cutter 1 (Endmill 

kecil) 

Biasanya untuk milling track 

tipis, seperti V-bit atau Endmill 

0.1 – 0.4 mm 

C2 Cutter 2 (Endmill 

sedang) 

Untuk pemotongan atau jalur 

isolasi sedikit lebih besar 

C3 Cutter 3 (Endmill 

besar) 

Untuk area isolasi luas, 

biasanya 0.8 – 1.0 mm 

C4 Cutter 4 (paling besar) Untuk clearing (menghapus 

tembaga yang luas) atau cutout 

PCB 

B Drill Bit / Bor 

(Boring) 

Untuk pengeboran lubang (via 

atau lubang kaki komponen) 

V V-Bit Untuk pemotongan 

menggunakan V-cutter, 

misalnya V-bit 30°, 0.1 mm 

ujung tajam 

FlatCAM tidak mengunci fungsi berdasarkan label ini. Artinya, label 

TT seperti C1 atau V hanya sebagai referensi pengguna, bukan sebagai 

parameter aktif yang mengubah gerakan mesin. 

• Tool Order: Mengatur urutan pemotongan untuk beberapa tool 

(jika lebih dari satu). 

Pilihan: No, Forward, Reverse 
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b. Add from DB 

• Tool Dia: Ukuran diameter alat potong dari database. Contoh: 0,1 

mm (atau bisa diketik manual). 

• Tombol Search and Add / Pick from DB digunakan untuk 

menambahkan alat dari database FlatCAM. 

c. Parameters for Tool 

• Passes: 

Jumlah lintasan (pengulangan) untuk membuat jalur isolasi. 

Contoh: 2 berarti proses akan dilakukan 2 kali, membuat jalur lebih 

lebar. 

• Overlap: 

Persentase tumpang tindih antar lintasan jika Passes > 1. 

Misal: 10% dari 0.7 mm = 0.07 mm overlap antara lintasan pertama 

dan kedua. 

• Milling Type: 

- Climb: Arah pemotongan mengikuti arah putaran tool 

(umumnya digunakan karena lebih halus). 

- Conventional: Berlawanan arah dengan putaran tool 

• Follow: 

Centang jika ingin tool mengikuti jalur pad tanpa offset (jarang 

dipakai untuk isolation) 

• Isolation Type: 

- Full: Mengelilingi seluruh pad dan jalur. 

- Ext: Hanya sisi luar. 

- Int: Hanya sisi dalam pad 

d. Tombol Apply 

• Apply parameters to all tools: 

Jika menggunakan lebih dari 1 tool, maka parameter yang sudah 

diatur akan diterapkan ke semua tool. 
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e. Common Parameters 

• Rest: Untuk membuat jalur hanya pada area yang belum terpotong 

oleh tool sebelumnya. 

• Combine: Menggabungkan beberapa hasil isolasi menjadi satu file 

geometry. ✓ Disarankan dicentang agar output tidak terpencar-

pencar. 

• Check Validity: ✓ Dicentang untuk memastikan semua jalur bisa 

dibentuk menjadi geometry valid sebelum diproses lebih lanjut. 

f. Generate Geometry 

Setelah pengaturan parameter pada Isolation Routing selesai, klik 

tombol "Generate Geometry" untuk membuat objek geometri 

pemrosesan jalur PCB berdasarkan file Gerber. Langkah ini akan 

menghasilkan Geometry Object yang nantinya akan digunakan untuk 

membuat file G-code : 

 

Gambar 4. 49 Proses Geometry Object Copper Wire 

(Sumber : Dokumen Pribadi, 2025) 

 

1) Plot Options 

• Multi-Color: Jika dicentang, jalur berbeda akan ditampilkan 

dalam warna yang berbeda. Berguna untuk identifikasi jalur 

yang kompleks. 
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2) Tools Table (Tabel Alat Potong) 

Tabel 4- 4 Tools Table (Tabel Alat Potong) 

Kolom Fungsi 

# Nomor urutan alat 

Dia Diameter pahat/mata bor (contoh: 0.700 mm) 

Offset Jalur offset: biasanya default ‘Path’ 

- Path : Pahat mengikuti tepat di atas garis aslinya. 

- In : Pahat bergerak ke dalam garis, cocok untuk 

lubang atau kontur bagian dalam. 

- Out : Pahat bergerak ke luar garis, cocok untuk 

memotong tepi luar jalur PCB. 

- Custom : Offset diatur secara manual sesuai 

kebutuhan khusus. 

Type Jenis pemrosesan: Iso, Rough, Finish 

- Iso (Isolation) : Untuk membuat jalur isolasi di 

sekitar jejak tembaga (copper trace). 

- Rough : Untuk membersihkan area tembaga yang 

luas di luar jalur, biasanya setelah isolasi. 

- Finish : Untuk pemrosesan akhir agar hasil 

potongan lebih halus dan presisi. 

TT Tool Type, misal C1 (Endmill biasa), B (bor), V (V-

bit) 

P Centang untuk mengaktifkan tool tersebut 

3) Parameters for Tool 1 

Tabel 4- 5 Parameters for Tool 

Parameter Fungsi 

Cut Z Kedalaman potong (contoh: -0.060 mm berarti 

memotong 0,06 mm ke bawah) 

Multi-Depth Jika dicentang, pemotongan bertahap (misal 

dari 0 ke -0.06 dalam beberapa pass) 
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Parameter Fungsi 

Travel Z Tinggi gerakan saat pindah antar posisi 

(biasanya 1-3 mm, agar tidak menabrak objek) 

Feedrate X-Y Kecepatan gerak horizontal (mm/menit), 

contoh: 100 mm/mnt 

Feedrate Z Kecepatan turun mata bor saat memotong 

(lebih rendah dari X-Y, contoh: 50 mm/mnt) 

Re-cut Pemotongan ulang jalur (biasanya tidak 

dicentang) 

Spindle 

Speed 

Kecepatan putar spindle (dalam RPM), contoh 

12000 rpm 

Dwell Delay jeda sebelum gerak (diaktifkan jika 

ingin menunggu putaran stabil) 

 

4) Common Parameters 

Tabel 4- 6 Common Parameters 

Parameter Fungsi 

Tool change Z Tinggi alat saat proses pergantian tool (tidak 

dicentang jika single tool CNC) 

End move Z Ketinggian setelah proses selesai (biasanya 

10–20 mm) 

End move X,Y Koordinat akhir setelah proses selesai 

(biasanya None) 

Preprocessor Format G-code output, untuk GRBL pilih: 

grbl_11 

5) Tools Section 

• Milling Tool: Proses milling untuk jalur tembaga. 

• Paint Tool: Untuk mengisi area, biasanya tidak digunakan 

untuk jalur PCB. 
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• NCC Tool: Untuk menghilangkan copper di sekitar jalur 

(negative copper clearance). 

6) Transformations 

Tabel 4- 7 Transformations 

Opsi Fungsi 

Scale Mengubah skala ukuran, biasanya 1.0000 

Offset Memindahkan posisi (X,Y), biasanya (0.0, 0.0) 

7) Proses Generate Geometry 

Setelah semua parameter di atas diatur selanjutnya klik tombol 

"Generate CNCJob Object", maka FlatCAM akan menghasilkan 

CNC Job berdasarkan Geometry Object yang telah dibuat 

g. Save G-code 

Hasil CNC Job ini bisa disimpan sebagai G-code dan dikirim ke 

mesin CNC menggunakan UGS atau G-code sender lainnya. 

 

Gambar 4. 50 Proses Save CNC Code Copper Wire 

(Sumber : Dokumen Pribadi, 2025) 

 

6. Pengaturan File Excellon 

Klik dua kali pada file Excellon yang telah dimasukkan, misalnya 

drill_1_16.xln, untuk membuka pengaturan detail file tersebut. Tentukan 

ukuran lubang yang akan digunakan dalam proses pengeboran. Apabila 

semua lubang ingin dipilih sekaligus, klik ikon tanda pagar (#) untuk 
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menyeleksi seluruh ukuran lubang. Setelah itu, klik tombol Drilling Tool 

untuk memulai proses pembuatan jalur lubang (drill path) pada layout PCB. 

 

Gambar 4. 51 Proses Pemilihan Lubang & Drilling Tool 

(Sumber : Dokumen Pribadi, 2025) 

 

Setelah tombol Drilling Tool ditekan, isilah parameter settingan berikut 

sesuai kebutuhan dan spesifikasi mesin CNC yang digunakan : 

 

Gambar 4. 52 Proses Drilling Tool 

(Sumber : Dokumen Pribadi, 2025) 

 

Parameter Pengisian: 

• Cut Z: Kedalaman pemotongan lubang hingga tembus PCB. 
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• Multi-Depth: Aktifkan jika proses pengeboran dilakukan secara 

bertahap (misalnya untuk material tebal). Jika satu kali bor cukup, 

biarkan tidak dicentang. 

• Travel Z: Jarak gerak vertikal spindle saat berpindah dari satu titik 

lubang ke titik lainnya (agar tidak menyentuh permukaan PCB saat 

bergerak). 

• Feedrate Z: Kecepatan turun bor saat melakukan pengeboran 

(mm/menit) 

• Spindle Speed: Kecepatan putar spindle motor dalam RPM 

(rekomendasi umum untuk mata bor kecil). 

• Dwell: Waktu jeda di dasar lubang sebelum naik kembali, isi 1.0000 

detik jika ingin bor menunggu sejenak agar lubang benar-benar bersih. 

• Offset Z: Biarkan 0.0000, kecuali jika Anda ingin mengatur offset 

vertikal tambahan. 

• Drill Slots: Centang jika file mengandung jalur bor memanjang (slot), 

jika hanya lubang bulat biasa, biarkan tidak dicentang. 

Setelah mengatur parameter tersebut, klik [Apply parameters to all tools] 

agar semua ukuran bor menggunakan pengaturan yang sama. 

Parameter Umum Tambahan: 

• Tool change Z: Centang dan isi 15.0000 (sumbu Z bergerak ke atas 

15mm) jika menggunakan lebih dari satu mata bor dan mesin 

mendukung tool changer otomatis. 

• Start Z dan End Move Z: Diisi 15.0000 (bergerak 15mm) untuk posisi 

awal dan akhir spindle di sumbu Z saat memulai atau mengakhiri 

pekerjaan. 

• End move X,Y: Biarkan None jika tidak perlu menggeser spindle ke 

posisi tertentu setelah pengeboran selesai. 

• Preprocessor: Biarkan default atau pilih grbl_11 jika menggunakan 

GRBL 1.1 sebagai firmware CNC. 
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Jika semua parameter telah diatur dengan benar, klik [Generate CNCJob 

Object] untuk membuat file CNC pekerjaan pengeboran lubang PCB. 

Simpan G-code dan kirim ke mesin CNC menggunakan UGS atau G-code 

sender lainnya. 

 

Gambar 4. 53 Save CNC Code drill 

(Sumber : Dokumen Pribadi, 2025) 

 

7. Pengaturan File Profile (Outline) 

File profile digunakan untuk menentukan garis batas atau dimensi luar dari 

papan PCB. Untuk memulai, buka menu File > Open > Open Gerber, lalu 

arahkan ke folder GerberFiles dan pilih file Profile. Setelah file terbuka, 

klik dua kali pada file tersebut untuk menampilkan pengaturan, kemudian 

pilih opsi Cutout Tool. Atur parameter-parameter sesuai kebutuhan proses 

pemotongan batas PCB : 
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Gambar 4. 54 Proses Cutout Tool Profile 

(Sumber : Dokumen Pribadi, 2025) 

 

• Source Object 

- Kind: Dipilih Single, artinya hanya satu board yang akan diproses 

(bukan panel multi-board). 

- Type: Dipilih Gerber, karena file sumber yang digunakan adalah 

file Gerber profile.gbr. 

• Cutout Tool 

- Tool Dia: Menunjukkan diameter mata bor/endmill yang 

digunakan untuk memotong outline papan PCB. 

• Tool Parameters 

- Cut Z: Menunjukkan kedalaman potong hingga menembus seluruh 

ketebalan PCB (umumnya 1.6 mm). 

- Multi-Depth: Proses pemotongan dilakukan secara bertahap (tidak 

langsung satu kali kedalaman penuh), untuk menghindari tekanan 

berlebih pada tool. 

- Margin: Sebagai jarak tambahan antara garis potong dengan garis 

outline PCB untuk keamanan. 

- Gap Size: Ukuran celah (jembatan) kecil yang dibiarkan tidak 

terpotong penuh agar papan tidak terlepas dari bahan saat proses 

milling. 
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- Gap Type: Dipilih Bridge, artinya menggunakan jembatan 

berbentuk lurus. 

• Automatic Bridge Gaps 

- Gaps: Jumlah jembatan (penahan) otomatis yang akan dibuat di 

sekitar PCB agar tidak jatuh saat pemotongan selesai. 

Setelah parameter diatur, tekan tombol [Generate Geometry] untuk 

membuat jalur potong outline berdasarkan pengaturan di atas. Kemudian 

klik dua kali pada hasil file geometry tersebut dan atur kembali parameter-

parameter di bagian Geometry Object sesuai kebutuhan (misalnya Cut Z, 

Feedrate, Spindle Speed, dll). 

 

Gambar 4. 55 Proses Geometry Profile 

(Sumber : Dokumen Pribadi, 2025) 

 

Jika semua parameter telah diatur dengan benar, klik [Generate CNCJob 

Object]. Simpan file G-code yang dihasilkan dan kirim ke mesin CNC 

menggunakan UGS (Universal G-code Sender). 
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Gambar 4. 56 Proses Save CNC Code Profile 

(Sumber : Dokumen Pribadi, 2025) 

 

8. File Output G-code 

Dari seluruh langkah pengolahan di atas, maka akan dihasilkan tiga buah 

file G-code yang memiliki fungsi masing-masing, yaitu: 

a. File G-code copper_top : Berfungsi untuk proses isolation routing yaitu 

menggambar jalur wiring pada permukaan tembaga PCB. 

b. File G-code drill : Digunakan untuk proses pengeboran lubang kaki 

komponen sesuai dengan posisi pad pada layout PCB. 

c. File G-code profile : Digunakan untuk memotong atau membentuk 

dimensi luar PCB sesuai outline yang telah dirancang. 

Ketiga file G-code tersebut siap dikirim dan dijalankan pada mesin CNC 

menggunakan software seperti UGS (Universal G-code Sender) untuk 

menghasilkan papan PCB fisik yang siap digunakan 

4.2.4. Proses Software UGS 

Universal G-code Sender (UGS) merupakan software antarmuka yang 

digunakan untuk mengirim file G-code ke mesin CNC berbasis Arduino yang 

menggunakan firmware GRBL. UGS berfungsi sebagai jembatan antara komputer 

dan mesin CNC, memungkinkan pengguna untuk mengontrol pergerakan motor 

stepper, memulai pemrosesan G-code, serta melakukan fungsi tambahan seperti 
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homing, jogging, dan monitoring status mesin secara real-time. Langkah-langkah 

Menggunakan Universal G-code Sender (UGS) : 

1. Buka Universal Gcode Sender (UGS) 

Jalankan aplikasi Universal G-code Sender (UGS) di komputer. 

Sambungkan Arduino Uno (yang telah terinstal firmware GRBL) ke 

komputer menggunakan kabel USB. 

Pada tampilan awal UGS, pilih Firmware: GRBL, kemudian sesuaikan Port 

yang digunakan oleh Arduino (misalnya COM3 atau COM5) dan atur Baud 

Rate ke 115200. Setelah itu, klik Connect untuk memulai komunikasi antara 

UGS dan mesin CNC. 

 

Gambar 4. 57 Proses Koneksi UGS 

(Sumber : Dokumen Pribadi, 2025) 

 

2. Verifikasi Status CNC 

Setelah mesin CNC terhubung melalui Universal Gcode Sender (UGS), 

akan ditampilkan status koneksi pada antarmuka perangkat lunak. Jika 

muncul status "IDLE" (siap) atau "ALARM", maka sistem CNC telah 

berhasil terhubung dengan benar. 

Status "ALARM" sering kali muncul saat pertama kali terhubung karena fitur 

safety lock bawaan GRBL, seperti belum dilakukan proses homing, limit 

switch aktif, atau karena UGS mendeteksi kondisi awal mesin yang belum 

aman. Untuk mengatasinya, biasanya cukup dengan menekan tombol 

Unlock atau menjalankan perintah $X agar mesin siap digunakan. 
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Gambar 4. 58 Indikasi Koneksi GRBL 

(Sumber : Dokumen Pribadi, 2025) 

 

3. Konfigurasi Mesin CNC 

Pada Universal Gcode Sender (UGS), fitur Setup Wizard memungkinkan 

pengguna untuk melakukan konfigurasi awal mesin CNC seperti pengaturan 

limit switch, homing, soft limit, serta kalibrasi gerakan sumbu X, Y, dan Z. 

Untuk memulai proses ini, klik tab Machine, lalu pilih Setup Wizard dan 

ikuti langkah-langkah konfigurasi sesuai kebutuhan mesin CNC 

 

Gambar 4. 59 Menu Setup Wizard 

(Sumber : Dokumen Pribadi, 2025) 

 

a. Koneksi (Connection) 

Langkah awal pada Setup Wizard adalah memastikan koneksi antara 

perangkat lunak UGS dengan mesin CNC yang menggunakan firmware 
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GRBL. Jika mesin telah terhubung dengan benar melalui kabel USB 

dan firmware GRBL telah terinstal, maka halaman ini akan 

menampilkan status "Connected to GRBL 1.1h" atau versi GRBL yang 

digunakan. Tampilan ini mengonfirmasi bahwa komunikasi antara 

komputer dan mesin CNC berhasil dilakukan. 

 

Gambar 4. 60 Connection pada Setup Wizard 

(Sumber : Dokumen Pribadi, 2025) 

 

b. Import Settings 

Pada tahap ini, pengguna diberikan opsi untuk mengimpor file 

konfigurasi (.txt) apabila sebelumnya telah menyimpan pengaturan 

mesin CNC. Namun, jika tidak memiliki file konfigurasi, langkah ini 

dapat dilewati dengan menekan tombol Next untuk melanjutkan ke 

tahap berikutnya. 
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Gambar 4. 61 Import Settings pada Setup Wizard 

(Sumber : Dokumen Pribadi, 2025) 

 

c. Motor Wiring 

Pada tahap ini, pengguna dapat menguji arah dan koneksi motor stepper 

di masing-masing sumbu (X, Y, dan Z) menggunakan tombol arah (X±, 

Y±, Z±). Jika gerakan motor berlawanan arah dari yang diharapkan, 

centang opsi Reverse direction pada sumbu yang sesuai. 

Catatan : Jika Soft Limits diaktifkan, tombol yang menyebabkan 

gerakan melampaui batas akan dinonaktifkan untuk melindungi mesin. 

 

Gambar 4. 62 Motor Wiring pada Setup Wizard 

(Sumber : Dokumen Pribadi, 2025) 
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d. Step Calibration 

Langkah ini digunakan untuk melakukan kalibrasi langkah motor 

stepper agar gerakan mesin CNC sesuai dengan ukuran sebenarnya di 

dunia nyata. 

Fungsi tab Step Calibration di Setup Wizard : 

• Menggerakkan sumbu (X, Y, Z) dengan tombol panah, 

• Mengukur pergerakan aktual menggunakan penggaris atau alat 

ukur presisi, 

• Memasukkan nilai aktual ke kolom Actual movement, 

• Kemudian software akan menghitung estimasi nilai langkah per 

milimeter (steps/mm) yang diperlukan, 

• Klik Update untuk menyimpan hasil kalibrasi baru 

 

Gambar 4. 63 Step Calibration Setup Wizard 

(Sumber : Dokumen Pribadi, 2025) 
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Gambar 4. 64 Proses Step Calibration Mesin CNC 

(Sumber : Dokumen Pribadi, 2025) 

 

e. Limit Switches 

Menu ini digunakan untuk mengatur dan menguji fungsi limit switch 

pada mesin CNC. Limit switch berfungsi sebagai pengaman agar mesin 

tidak bergerak melebihi batas fisik area kerja. 

Di halaman ini, pengguna dapat : 

• Mengaktifkan fitur limit switch dengan mencentang Enable limit 

switches, 

• Menguji setiap sakelar batas pada sumbu X, Y, dan Z dengan 

menekan masing-masing tombol virtual (X, Y, Z), 

• Pastikan tombol limit switch ditekan secara manual setidaknya 2 

detik agar sistem mengenali sinyalnya, 

• Centang opsi Invert limit switches jika logika sakelar perlu dibalik 

(misalnya: dari NC ke NO). 
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Gambar 4. 65 Limit Switches Setup Wizard 

(Sumber : Dokumen Pribadi, 2025) 

 

f. Homing 

Fitur Homing berfungsi untuk menemukan koordinat absolut mesin 

CNC dengan menggerakkan tiap sumbu ke arah limit switch secara 

otomatis hingga menyentuh titik nol mesin. 

Pada halaman ini, pengguna dapat : 

• Mengaktifkan fungsi homing dengan mencentang opsi Enable 

homing, 

• Menentukan arah gerak tiap sumbu (X, Y, Z) menuju limit switch 

masing-masing (misalnya -X, -Y, +Z), 

• Melakukan pengujian siklus homing dengan menekan tombol Try 

homing, 

• Jika pergerakan tidak sesuai arah atau berbahaya, tekan tombol 

Abort untuk menghentikan proses. 
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Gambar 4. 66 Homing Setup Wizard 

(Sumber : Dokumen Pribadi, 2025) 

 

g. Soft Limits 

Fitur Soft Limits berfungsi untuk mencegah mesin bergerak melebihi 

area kerja yang aman secara perangkat lunak, tanpa harus menyentuh 

limit switch fisik. 

Pada halaman ini, pengguna dapat : 

• Mengaktifkan fitur dengan mencentang Enable soft limits. 

• Melakukan proses Home terlebih dahulu untuk menandai posisi nol 

absolut. 

• Menggerakkan masing-masing sumbu (X, Y, Z) ke titik paling jauh 

yang aman secara manual. 

• Setelah mencapai batas maksimum tiap arah, masukkan nilai 

tersebut ke kolom Update the max travel distance, lalu klik Update. 

 

Gambar 4. 67 Soft Limits Setup Wizard 

(Sumber : Dokumen Pribadi, 2025) 
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Jika seluruh langkah pada Setup Wizard telah diselesaikan dengan 

benar, klik tombol Finish untuk menyimpan dan mengaktifkan semua 

konfigurasi mesin CNC. 

4. Konfigurasi Firmware GRBL Secara Manual 

Setelah konfigurasi awal melalui Setup Wizard selesai, dapat dilakukan 

penyesuaian lebih lanjut terhadap parameter firmware GRBL secara manual 

untuk mengoptimalkan kinerja dan akurasi pergerakan mesin CNC. 

Pengaturan ini bertujuan untuk menyesuaikan karakteristik mekanik sistem 

secara presisi, sebagaimana telah dijelaskan pada Dasar Teori 2.2.32 – 

Software Universal G-Code Sender, bagian 4. Firmware Machine UGS.  

Pengaturan ini dilakukan melalui menu Machine > Firmware Settings pada 

UGS dengan mengubah nilai-nilai parameter konfigurasi GRBL secara 

manual sesuai kebutuhan mesin CNC. 

 

Gambar 4. 68 Proses Settings Firmware Machine 

(Sumber : Dokumen Pribadi, 2025) 

 

Beberapa parameter utama yang telah disesuaikan antara lain : 

• $100, $101, dan $102 untuk resolusi langkah (Travel Resolution) 

sumbu X, Y, dan Z sesuai dengan perhitungan langkah per mm. 

Mesin CNC ini menggunakan mode microstepping 1/16, sehingga 

motor stepper NEMA 17 menghasilkan 3200 langkah per putaran penuh 

(200 langkah × 16 microstep).  
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- Sumbu X dan Y menggunakan sistem pulley GT2 dengan 20 gigi 

dan belt GT2 dengan pitch 2 mm, sehingga : 

𝑇𝑟𝑎𝑣𝑒𝑙 𝑅𝑒𝑠𝑜𝑙𝑢𝑡𝑖𝑜𝑛 =
3200 𝑙𝑎𝑛𝑔𝑘𝑎ℎ

20 𝑔𝑖𝑔𝑖 ×  2 𝑚𝑚
= 80 𝑙𝑎𝑛𝑔𝑘𝑎ℎ/𝑚𝑚 

- Sumbu Z menggunakan leadscrew T8 Lead 8 mm (Pitch 2 mm, 4 

Start), sehingga dalam satu putaran penuh, screw bergerak sejauh 

8 mm, maka : 

𝑇𝑟𝑎𝑣𝑒𝑙 𝑅𝑒𝑠𝑜𝑙𝑢𝑡𝑖𝑜𝑛 =
3200 𝑙𝑎𝑛𝑔𝑘𝑎ℎ

8 𝑚𝑚
= 400 𝑙𝑎𝑛𝑔𝑘𝑎ℎ/𝑚𝑚 

• $110–$112 untuk kecepatan gerak maksimum tiap sumbu. 

• $120–$122 untuk nilai akselerasi tiap sumbu. 

• $130–$132 untuk jarak maksimum pergerakan sumbu sesuai dimensi 

kerja mesin. 

• $20, $21, dan $22 untuk mengaktifkan soft limit, hard limit, serta fungsi 

homing. 

• $30 dan $31 diatur sesuai kapasitas kecepatan spindle motor, yaitu 

maksimum 12.000 RPM. 

5. Unggah File Gcode 

Setelah proses pembuatan G-code di FlatCAM selesai dan konfigurasi 

mesin CNC telah dilakukan, langkah selanjutnya adalah mengunggah file 

G-code (.nc) tersebut ke Universal Gcode Sender (UGS). Caranya, buka 

UGS lalu masuk ke menu File > Open, kemudian pilih file G-code yang 

ingin dijalankan pada mesin CNC. 

 

Gambar 4. 69 Proses Input File Gcode 

(Sumber : Dokumen Pribadi, 2025) 
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6. Atur Titik Nol 

Setelah semua konfigurasi selesai dan file G-code berhasil diunggah, 

langkah selanjutnya adalah mengatur titik nol (origin) mesin CNC. Arahkan 

pahat secara manual ke posisi awal kerja yang diinginkan pada sumbu X, Y, 

dan Z. 

 

Gambar 4. 70 Proses Titik Nol pada Benda Kerja (PCB) 

(Sumber : Dokumen Pribadi, 2025) 

 

Setelah posisi sesuai, klik tombol “Reset Zero” pada masing-masing sumbu 

(X, Y, dan Z) di UGS. Langkah ini penting agar mesin CNC mengenali titik 

awal sebagai acuan sebelum mengeksekusi jalur G-code. 

 

Gambar 4. 71 Proses Reset Zero pada UGS 

(Sumber : Dokumen Pribadi, 2025) 
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7. Autoleveling PCB dan Pengujian Kerataan Bed Mesin CNC 

Sebelum proses autoleveling dilakukan, permukaan bed mesin CNC 

diperiksa terlebih dahulu untuk memastikan kerataannya menggunakan alat 

waterpass. Pengujian ini bertujuan untuk mendeteksi adanya kemiringan 

pada bed yang dapat memengaruhi hasil ukiran jalur PCB. 

 

Gambar 4. 72 Proses Waterpass Test pada Bed Mesin CNC 

(Sumber : Dokumen Pribadi, 2025) 

Berdasarkan hasil pengukuran kerataan permukaan bed mesin CNC 

menggunakan alat waterpass manual pada sumbu vertikal, horizontal, dan 

diagonal sebagaimana ditunjukkan pada Gambar 4.72, diperoleh bahwa 

posisi gelembung air masih berada di antara dua garis tengah indikator. Hal 

ini menunjukkan bahwa permukaan bed CNC berada dalam kondisi yang 

masih rata dan layak digunakan, tanpa kemiringan yang signifikan pada 

ketiga arah pengukuran tersebut. Hal ini menjadi indikasi bahwa secara 

umum, struktur rangka dan bidang kerja mesin sudah cukup presisi. 

Namun, walaupun bed terlihat rata, proses autoleveling tetap perlu 

dilakukan karena beberapa faktor teknis berikut: 

• PCB dapat memiliki ketebalan yang tidak merata. 

• Permukaan bed CNC terbuat dari bahan filamen PLA yang bisa berubah 

bentuk karena panas selama proses pencetakan 3D 

Oleh karena itu, klem dipasang pada sisi PCB untuk menahannya agar tetap 

rata dan stabil selama proses probing berlangsung. Setelah titik nol (origin) 

ditentukan pada pojok kiri bawah PCB, maka langkah berikutnya adalah 

melakukan autoleveling. Autoleveling dilakukan dengan cara : 
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a. Memasang probe/capit buaya auto-leveling ke spindle atau ujung mata 

pahat, dan ujung lainnya ke permukaan PCB. 

b. Mengaktifkan fitur “AutoLeveler” pada software G-code sender seperti 

UGS atau bCNC. 

c. Mengatur parameter-parameter autoleveling, antara lain 

• Resolution : menentukan jarak antar titik probing (misalnya 1.0 

mm untuk detail tinggi, atau 2.0 mm untuk proses cepat). 

• Gcode Z surface : tetap diisi 0.0 karena hasil probe 

sebelumnya sudah menentukan titik Z = 0 sebagai permukaan 

referensi. 

• Z Retract : misalnya 100% dari nilai Z End pada G-code agar 

pahat naik cukup aman setelah probe tiap titik. 

d. Kemudian klik tombol “Scan Surface” untuk memulai pemetaan. CNC 

akan bergerak ke titik-titik dalam grid, melakukan probing, dan 

menyusun data heightmap.  

e. Setelah selesai, centang “Apply to Gcode” agar hasil heightmap 

diterapkan ke jalur G-code secara otomatis. 

 

Gambar 4. 73 Proses Autoleveler  pada PCB 

(Sumber : Dokumen Pribadi, 2025) 
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Gambar 4. 74 Proses Autoleveler  pada UGS 

(Sumber : Dokumen Pribadi, 2025) 

 

f. Klik “Export G-code” untuk menghasilkan file G-code baru yang telah 

disesuaikan dengan kontur permukaan PCB.  

g. Kemudian simpan file autoleveled.gcode tersebut dan lepaskan probe 

atau capit buaya auto-leveling yang terhubung dengan spindel dan PCB. 

Langkah ini memastikan bahwa setiap pergerakan sumbu Z saat proses 

grafir akan menyesuaikan ketinggian riil permukaan PCB, sehingga 

kedalaman grafir tetap konsisten meskipun permukaan PCB tidak 

sepenuhnya rata. 

8. Kirim File Gcode 

Setelah titik nol dan proses auto-leveling selesai diatur, lakukan 

perintah “Return to Zero” untuk mengembalikan posisi mesin ke titik 

awal koordinat kerja (X, Y, dan Z) yang telah ditentukan sebelumnya. 

Pastikan mata bor (sumbu Z) telah menyentuh permukaan PCB dengan 

tepat dan tidak melayang. Selanjutnya, kirimkan file autoleveled.gcode 

ke mesin CNC dengan mengklik tombol “Send” pada Universal Gcode 

Sender (UGS). 

Perintah ini akan memulai eksekusi jalur kerja CNC sesuai file G-code 

yang diinput. Jika berhasil, status CNC akan berubah menjadi "Run", 



148 

 

 

 

menandakan bahwa proses pemotongan atau pencetakan sedang 

berjalan. 

 

Gambar 4. 75 Proses kirim File G-Code 

(Sumber : Dokumen Pribadi, 2025) 

 

9. Pantau Proses CNC 

Selama proses berjalan, pengguna dapat memantau status perintah, 

posisi koordinat sumbu, serta pesan yang dikirimkan oleh GRBL 

melalui panel Console dan Status pada Universal Gcode Sender (UGS). 

Informasi ini sangat membantu untuk memastikan bahwa mesin CNC 

berjalan sesuai jalur G-code dan tidak terjadi kesalahan. 

Jika selama proses berjalan terjadi kesalahan atau kondisi tidak 

diinginkan, pengguna dapat segera mengambil tindakan darurat dengan 

menekan tombol Pause, E-Stop, atau Soft-Reset yang tersedia pada 

UGS untuk menghentikan atau menjeda mesin CNC secara aman. 

 

Gambar 4. 76 Proses Running Mesin CNC 

(Sumber : Dokumen Pribadi, 2025) 


